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การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word 

เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (E-book)
รายงานการฝึกอบรมเชิงปฏิบัติการ 2

	 วิสัยทัศน์ สำ�นักพิมพ์เป็นหน่วยงานที่ผลิตและจัดจำ�หน่ายสื่อสิ่งพิมพ์ที่มีคุณภาพแบบครบวงจร และทันสมัย

	 พันธกิจ 
	 1. พัฒนาระบบการผลิตสื่อสิ่งพิมพ์วิชาการต่างๆ ที่มีคุณภาพและมาตรฐาน สอดรับกับแนวทางการศึกษาทางไกล

    		  ของมหาวิทยาลัย

	 2. มุ่งให้บริการและพัฒนาระบบการจัดพิมพ์เอกสารลับของประเทศ

	 3  พัฒนาเผยแพร่และจัดจำ�หน่ายสิ่งพิมพ์ที่ทันสมัยให้มีความหลากหลาย และตอบสนองความต้องการของสังคม

	 4. มุ่งให้บริการวิชาการและวิชาชีพด้านการพิมพ์ ให้มีมาตรฐานและทันสมัย

	 5. พัฒนาระบบบริหารจัดการองค์กรด้านสนับสนุนการศึกษาทางไกลที่ทันสมัย ให้มีประสิทธิภาพ และประสิทธิผล

	 ตาราง

สพบ.01

ลำ�ดับความสำ�คัญ 1

ประเภทโครงการ โครงการพัฒนาบุคลากรให้ได้รับความรู้และทักษะทางวิชาการ

ชื่อโครงการ/ชื่อผู้ขอรับทุน หรือ

ชื่อผู้รับผิดชอบโครงการ(ถ้าระบุได้)

โครงการฝึกอบรมเชิงปฏิบัติการ เรื่อง “การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word 

เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (E-book)”

วัตถุประสงค์

ของโครงการ

(1) เพื่อให้บุคลากรของสำ�นักพิมพ์ ได้รับการพัฒนาทักษะเดิม (Upskill) และเสริมสร้างทักษะใหม่ (Reskill) 

ที่จำ�เป็นในการทำ�งานโดยสามารถนำ�เทคโนโลยีสารสนเทศมาปรับใช้ให้เข้ากับการทำ�งานในยุคดิจิทัล

(2) เพื่อให้บุคลากรของสำ�นักพิมพ์ สามารถนำ�องค์ความรู้ที่ได้รับไปประยุกต์ใช้เพื่อเพิ่มประสิทธิภาพ ใน

การปฏิบัติงานจัดหน้าเอกสารการสอนชุดวิชาด้วยโปรแกรม Microsoft Word เพื่อรองรับสำ�หรับการสร้าง

หนังสืออิเล็กทรอนิกส์ (E-book)

ประโยชน์ที่คาดว่าจะได้รับจากโครงการ

(มหาวิทยาลัย)

ประโยชน์ที่คาดว่าจะได้รับจากโครงการ

(สำ�นักพิมพ์)

(1) บุคลากรของมหาวิทยาลัยได้รับการเสริมสร้างสมรรถนะ พัฒนาทักษะเดิม (Upskill) เพิ่มเติมทักษะใหม่ 

(Reskill) เพื่อรองรับการเป็นมหาวิทยาลัยดิจิทัล

(2) บุคลากรของสำ�นักพิมพ์สามารถสร้างไฟล์งานอาร์ตเวิร์คสำ�หรับสิ่งพิมพ์ และสามารถสร้างหนังสือ

อิเล็กทรอนิกส์ (E-book) ได้อย่างมีคุณภาพมาตรฐาน

(1) บุคลากรของสำ�นักพิมพ์มีความรู้มีการพัฒนาทักษะจากการเรียนรู้วิธีการทำ�งานใหม่ ๆ (Upskill) เพื่อเพิ่ม

ประสิทธิภาพการปฏิบัติงานที่ทำ�อยู่ให้แตกต่างจากเดิม 

(2) บุคลากรของสำ�นักพิมพ์ได้รับความรู้ความเข้าใจที่เพิ่มมากขึ้นจากการอบรมทักษะใหม่ (Reskill) ในการ

ปฏิบัติงานเพื่อให้เท่าทันและรองรับการเปลี่ยนแปลง

(3) บุคลากรของสำ�นักพิมพ์สามารถสร้างไฟล์งานอาร์ตเวิร์คสำ�หรับส่งพิมพ์ และสามารถสร้างหนังสือ

อิเล็กทรอนิกส์ (E-book)

จำ�นวน (คน) 25 คน

จำ�นวนเงิน (บาท) 22,480

กำ�หนดการ(วัน/เดือน/ปี) ไตรมาส 4 (กรกฎาคม - กันยายน)

รูปแบบ

เผชิญหน้า

มสธ. a

ตจว./ตปท.โปรดระบุ

สถานที่/ประเทศ
-

สอดคล้องกับวิสัยทัศน์/แผนการพัฒนา

ของหน่วยงานในข้อใด
1-5

ข้อมูลโครงการ
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	 1. ชื่อโครงการ ฝึกอบรมเชิงปฏิบัติการ เรื่อง “การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word  

เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (E-book)”

	 4. ความสำ�คัญของโครงการ การพัฒนาบุคลากรให้ได้รับความรู้และทักษะทางวิชาการ โครงการ “ฝึกอบรมเชิง

ปฏิบัติการ เรื่อง การจัดหน้าเอกสารการสอนชุดวิชาด้วยโปรแกรม MS Word เพื่อรองรับสำ�หรับการหนังสืออิเล็กทรอนิกส์ 

(E-book)” การเสริมสร้างและพัฒนาฐานทักษะเดิม เพิ่มเติมขีดความสามารถในการทำ�งานโดยการนำ�เทคโนโลยีดิจิทัลมา

ปรับใช้ให้เข้ากับการทำ�งานในปัจจุบัน (Upskill) รวมถึงการสร้างทักษะการทำ�งานใหม่ที่จำ�เป็นในการทำ�งาน เรียนรู้ทักษะ

ใหม่ (Reskill) ให้เท่าทันการเปลี่ยนแปลงสามารถเพิ่มประสิทธิภาพในการทำ�งานและรองรับการก้าวสู่มหาวิทยาลัยดิจิทัล

	 2. ประเภทโครงการ โครงการพัฒนาบุคลากรให้ได้รับความรู้และทักษะทางวิชาการ

และสอดคล้องกับพันธกิจ และประเด็นยุทธศาสตร์ของ มสธ. 20 ปี (ปี พ.ศ. 2561 – 2580) ในข้อใดโปรดระบุ : พันธกิจที่ 5 : 

จัดให้มีการศึกษาอย่างต่อเนื่อง ตลอดชีวิต ประเด็นยุทธศาสตร์ 10 : พัฒนาองค์กรที่มีผลสัมฤทธิ์ด้านบริหารทรัพยากรบุคคล

ที่เป็นสากล (แผน 20 ปี) ประเด็นยุทธศาสตร์ที่ 10 : พัฒนาระบบบริหารจัดการทรัพยากรบุคคล เพื่อมุ่งสู่การเป็นองค์กร 

ที่มีผลสัมฤทธิ์สูง (แผน 5 ปี)

	 5. วัตถุประสงค์ของโครงการ
		  เพื่อให้บุคลากรของสำ�นักพิมพ์ ได้รับการพัฒนาทักษะเดิม (Upskill) และเสริมสร้างทักษะใหม่ (Reskill) ที่จำ�เป็น

ในการทำ�งานโดยสามารถนำ�เทคโนโลยีสารสนเทศมาปรับใช้ให้เข้ากับการทำ�งานในยุคดิจิทัล

		  เพื่อให้บุคลากรของสำ�นักพิมพ์ สามารถนำ�องค์ความรู้ที่ได้รับไปประยุกต์ใช้เพื่อเพิ่มประสิทธิภาพ ในการปฏิบัติ

งานจัดหน้าเอกสารการสอนชุดวิชาด้วยโปรแกรม Microsoft Word เพื่อรองรับสำ�หรับการสร้างหนังสืออิเล็กทรอนิกส์ 

(E-book)

	 3. ชื่อและประวัติของผู้ขอรับทุน/ผู้รับผิดชอบโครงการ
ชื่อภาษาไทย นางสาวชมชัด อินทกาญจน์

ชื่อภาษาอังกฤษ Miss. CHOMCHAT INTAKARN

วุฒิการศึกษา เทคโนโลยีบัณฑิต

ตำ�แหน่ง นักวิชาการโสตทัศนศึกษา สังกัด ฝ่ายจัดฝึกอบรมเทคโลยีการพิมพ์ สำ�นักพิมพ์  โทรศัพท์ 02 504 7745

เข้ารับราชการที่ มสธ. เมื่อ วันที่ 1 พฤษภาคม 2562  จะเกษียณอายุราชการในปี 2592     

		   

		  ขณะนี้ได้รับทุนอื่น ๆ จากมหาวิทยาลัยหรือไม่	  	 ไม่ได้รับ

		  ขณะนี้ลาศึกษาต่อเต็มเวลา / ลาในลักษณะอื่นเต็มเวลาหรือไม่	  	 ไม่ได้ลา

		  ขณะนี้ผู้ขอรับทุนมีชุดวิชาที่ต้องรับผิดชอบในการผลิต/ปรับปรุงประจำ�ภาคการศึกษาในปีงบประมาณที่ขอรับทุน 	

		    หรือไม่	    ไม่มี

สพบ.02ข้อมูลโครงการ
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	 7. ระยะเวลาดำ�เนินการ ไตรมาสที่ 4 ประจำ�ปีงบประมาณ พ.ศ. 2565 (กรกฎาคม – กันยายน 2565)

	 8. วิธีดำ�เนินการ ฝึกอบรมเชิงปฏิบัติการ ณ ห้องปฏิบัติการคอมพิวเตอร์ จำ�นวน 2 วัน (ทฤษฎีและปฏิบัติ)

				    ผู้เข้าฝึกอบรม 25 คน (รวม 26 คน) วิทยากรภายนอก 1 คน 

				    จัดฝึกอบรมเป็น 2 ช่วง 2 วัน	

	 6. ประโยชน์ที่คาดว่าจะได้รับ (ในเชิงรูปธรรม)  

เมื่อเสร็จสิ้นโครงการแล้วผู้ขอรับทุนจะนำ�ความรู้และประสบการณ์ที่ได้รับไปใช้ประโยชน์ในกิจกรรม 2 ส่วน ดังนี้

สพบ.02

(1) บุคลากรของมหาวิทยาลัยได้รับการเสริม

สร้างสมรรถนะ พัฒนาทักษะเดิม (Upskill) 

เพิ่มเติมทักษะใหม่ (Reskill) เพื่อรองรับการ

เป็นมหาวิทยาลัยดิจิทัล

(2) บุคลากรของสำ�นักพิมพ์สามารถสร้างไฟล์

งานอาร์ตเวิร์คสำ�หรับสิ่งพิมพ์ และสามารถ

สร้างหนังสืออิเล็กทรอนิกส์ (E-book) 

ได้อย่างมีคุณภาพมาตรฐาน

ความรู้และประสบการณ์ที่ได้รับ
นี้มีประโยชน์ต่อมหาวิทยาลัย

อย่างไร

ผู้ขอรับทุนจะนำ�ประโยชน์ที่ได้รับมา
ใช้ในการพัฒนางานที่รับผิดชอบ

อย่างไรในเชิงรูปธรรม

(1) บุคลากรของสำ�นักพิมพ์มีความรู้มีการพัฒนา

ทักษะจากการเรียนรู้วิธีการทำ�งานใหม่ ๆ (Upskill) 

เพื่อเพิ่มประสิทธิภาพการปฏิบัติงานที่ทำ�อยู่ให้

แตกต่างจากเดิม 

(2) บุคลากรของสำ�นักพิมพ์ได้รับความรู้ความ

เข้าใจที่เพิ่มมากขึ้นจากการอบรมทักษะใหม่  

(Reskill) ในการปฏิบัติงานเพื่อให้เท่าทันและ

รองรับการเปลี่ยนแปลง

(3) บุคลากรของสำ�นักพิมพ์สามารถสร้างไฟล์

งานอาร์ตเวิร์คสำ�หรับส่งพิมพ์ และสามารถ 

สร้างหนังสืออิเล็กทรอนิกส์ (E-book)

ข้อมูลโครงการ
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สพบ.02

	 9. งบประมาณของโครงการจำ�แนกตามหมวด 

		

	 ค่าตอบแทนวิทยากรภายนอก 

		  จำ�นวน 1 คน 2 วัน ๆ ละ 6 ชั่วโมง ๆ ละ 1,000 บาท				    เป็นเงิน 12,000 บาท

	

	 ค่าพาหนะวิทยากรภายนอก

		  จำ�นวน 1 คน  2 วัน เหมาจ่าย วันละ 600 บาท					     เป็นเงิน  1,200 บาท

	

	 ค่าอาหารกลางวัน รวมวิทยากร

		  จำ�นวน 29 คน จำ�นวน 2 วัน ๆ ละ 1 มื้อ ๆ ละ 80 บาท				    เป็นเงิน   4,640 บาท

	 ค่าอาหารว่างและเครื่องดื่ม รวมวิทยากร

		  จำ�นวน 29 คน จำ�นวน 2 วัน ๆ ละ 2 มื้อ ๆ ละ 40 บาท				    เป็นเงิน   4,640 บาท

							     

					              รวมเป็นเงิน 22,480 บาท (สองหมื่นสองพันสี่ร้อยแปดสิบบาทถ้วน)
		

Baht

Baht

Baht

ข้อมูลโครงการ
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	 	  	   1	    วันที่ 18 กรกฎาคม 2565

09.00 - 10.00 น.	 พิธีเปิด แนะนำ�คุณสมบัติใหม่ในโปรแกรม Microsoft Office

			   พื้นที่การทำ�งานของโปรแกรม Microsoft Word เครื่องมือพื้นฐาน

10.00 - 10.15 น.	 พักรับประทานอาหารว่าง

10.15 - 12.00 น. 	 การตั้งค่าเอกสาร การสร้างหน้างานสำ�หรับเอกสารการสอน

12.00 - 13.00 น.	 พักรับประทานอาหารกลางวัน

13.00 - 14.30 น. 	 การสร้างข้อความ การจัดรูปแบบ Font ด้วย Charecter Style

			   การจัดรูปแบบย่อหน้า Paragraph Style

			   ระยะ Tap การสร้างสารบัญ

14.30 - 14-45 น. 	 พักรับประทานอาหารว่าง

14.45 - 16-00 น.	 การกำ�หนดรูปแบบเลขลำ�ดับหัวข้อ 

			   การใส่เลขหน้า ส่วนหัว ส่วนท้ายหนังสือ

			   การสร้างหน้าหลัก Master page สำ�หรับงานจัดหน้าเอกสารการสอน

			   ทิป & เทคนิค การใช้คีย์ลัด Short cut

	 เรื่อง “การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word 
เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (e-Book)”

ณ ห้องปฏิบัติการคอมพิวเตอร์ มหาวิทยาลัยสุโขทัยธรรมาธิราช
จำ�นวน 2 วัน เวลา 09.00 - 16.00 น.

กำ�หนดการฝึกอบรม
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	 เรื่อง “การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word 
เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (e-Book)”

ณ ห้องปฏิบัติการคอมพิวเตอร์ มหาวิทยาลัยสุโขทัยธรรมาธิราช
จำ�นวน 2 วัน เวลา 09.00 - 16.00 น.

			       2	  วันที่ 19 กรกฎาคม 2565

09.00 - 10.30 น.	 ทบทวน การสร้างตาราง การแทรกรูปภาพ แทรกแผนภาพกราฟิก แทรก Smart Art

			   การเพิ่มกล่องข้อความ คำ�อธิบายภาพ 

			   การสร้าง Infographic การแก้ไขเกี่ยวกับภาพ ตาราง กราฟิก 	

10.30 - 10.45 น.	 พักรับประทานอาหารว่าง

10.45 - 12.00 น.	 การแทรกสัญลักษณ์ สูตรคณิตศาสตร์ และอื่น ๆ

			   การแก้ไขคำ�ผิด การค้นหาและแก้ไขคำ�ผิด ข้อความ การตรวจสอบคำ�ผิด

12.00 - 13.00 น.	 พักรับประทานอาหารกลางวัน

13.00 - 14.30 น. 	 การ Save ไฟล์งาน การ Package การตรวจสอบความถูกต้อง

			   แปลงไฟล์งาน PDF สำ�หรับงานพิมพ์ การแปลงไฟล์งาน PDF สำ�หรับงาน E-book 

			   การแปลงไฟล์ EPUB

14.30 - 14.45 น.	 พักรับประทานอาหารว่าง

14.45 - 16.00 น.	 การสร้างหนังสือ E-book  การตั้งค่า การสร้างสารบัญ แทรกเพิ่มหน้า ลดหน้า

                              วิธีการแทรกปกหนังสืออิเล็กทรอนิกส์ (E - book)

			   การใส่สื่อ Multimedia เสียง และวีดีโอ

                              การตรวจสอบงานด้วยโปรแกรม Adobe Acrobat

                              การตั้งค่า และบันทึกไฟล์สำ�หรับงานหนังสืออิเล็กทรอนิกส์ (E - book)

		          	 สาธิตวิธีการติดตั้งโปรแกรมสำ�หรับอ่านงานหนังสืออิเล็กทรอนิกส์ (E - book)

			   ปัญหาและการแก้ไข ถามตอบ และสรุปการฝึกอบรม

กำ�หนดการฝึกอบรม
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วิธีการดำ�เนินการฝึกอบรม

ขั้นเตรียมการ

กำ�หนดหัวข้อการฝึกอบรม ทาบทามวิทยากร กำ�หนดการ วัน เวลา

จัดทำ�รายละเอียดหัวข้อการฝึกอบรม เนื้อหา กำ�หนดการ

จัดทำ�ลิ้งค์ สื่อประชาสัมพันธ์ 

 ติดต่อสถานที่ และอุปกรณ์คอมพิวเตอร์ที่ใช้ฝึกอบรม

จัดทำ�เอกสารขออนุมัติจัด หนังสือเชิญวิทยากร ขอความอนุเคราะห์หน่วยงานต่าง ๆ 

ประสานงานหน่วยงานที่เกี่ยวข้อง (สำ�นักคอมพิวเตอร์, ศูนย์สัมมนาและฝึกอบรม)

 ติดต่อวิทยากรเพื่อเตรียมความพร้อม

 สร้างแบบประเมินผลการฝึกอบรม Google Forms

แจ้ง กำ�หนดการ วัน เวลา ผู้เข้าฝึกอบรม
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ขั้นดำ�เนินการ

วิธีการดำ�เนินการฝึกอบรม

เปิดการอบรม ดำ�เนินรายการ กล่าวต้อนรับ แนะนำ�หัวข้อการอบรม แนะนำ�วิทยากร

 ดูแลห้องอบรม ดูแลผู้ฝึกอบรม

บันทึกวีดีโอการฝึกอบรม แชร์วีดีโอเผยแพร่ออกอากาศสดไปยัง Facebook Fanpage 
“สำ�นักพิมพ์ ฝึกอบรมการพิมพ์ มสธ.” 

ประสานงานอาหารเบรค อาหารกลางวัน เครื่องดื่ม 

 เป็นสื่อกลางในการพูดคุย แนะนำ� สอบถามคำ�ถามวิทยากร

แนะนำ� แก้ไขปัญหา ในระหว่างการฝึกอบรม

จัดเตรียมของรางวัล ร่วมตอบคำ�ถามให้ฝึกอบรม

กล่าวขอบคุณวิทยากร ขอบคุณผู้ฝึกอบรม เชิญชวนตอบแบบประเมินผลการฝึกอบรม 
และประชาสัมพันธ์การชมวีดีโอการอบรมย้อยหลังผ่าน Facebook Fanpage 

“สำ�นักพิมพ์ ฝึกกอบรมการพิมพ์ มสธ.”

 ปิดการอบรม
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วิธีการดำ�เนินการฝึกอบรม

ขั้นหลังดำ�เนินการ

 สรุปข้อมูลการฝึกอบรม การประเมินผลความพึงพอใจ การนำ�ความรู้ไปใช้
ประโยชน์ ความคิดเห็น ข้อเสนอแนะ

จัดส่งไฟล์นำ�เสนอของวิทยากรให้ฝึกอบรมทาง line กลุ่ม “PR สำ�นักพิมพ์”

เผยแพร่ภาพการจัดอบรมผ่าน  Facebook Fanpage  

“สำ�นักพิมพ์ ฝึกอบรมการพิมพ์ มสธ.”

 เก็บรวมรวบเอกสาร หลักฐานการฝึกอบรม 

 จัดทำ�รายงานผลการฝึกอบรม เสนอต่อผู้อำ�นวยการสำ�นักพิมพ์
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เนื้อหาการฝึกอบรม

SELF-PUBLISHING
DESIGN AND PREPRESS

Prasit Klongnguluerm

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• การกําหนดตัวเลือกใน Word หรือ Word Options เพ่ือใหวางแผนการการออกแบบ
จัดหนาในโปรแกรม Word ใหถูกตองและเหมาะสมการการผลิตสื่อสิ่งพิมพ
คําส่ัง : Home > Options

• การกําหนดตวัเลอืกกอนปฏิบัติงาน ชวยใหการทํางานเปนไปตามเปาหมายที่ตองการ 
การกําหนดตวัเลอืก จะครอบคลุมการทํางานเอกสารทั้งหมด 

• การกําหนดตวัเลอืก ชวยเพิ่มความสะดวกรวดเร็วในการทํางาน

• การกําหนดตวัเลอืกควรกําหนดกอนเริ่มงานไฟลใหมทุกครั้ง เนื่องจากบางตัวเลือกจะเปนการ
กําหนดที่ระดับไฟล 
กรณี ตัวเลือกที่ใชระดับโปรแกรม ควรตองกําหนดไวกอนที่จะสรางเอกสารใหม หรือกําหนดใหมี
ผลกับทุกเอกสารที่เปดข้ึนมา (All New Documents)
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เนื้อหาการฝึกอบรม

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Display > Printing Options 

ตัวเลือกตางๆ ที่แสดงผลหนาจอ กําหนดใหพิมพ หรือ

ไมตองพิมพ มีผลกับความเร็วในการพิมพ และความถูกตอง

ในการพิมพ (ทั้งการพิมพที่ใชในสํานักงาน และการพิมพ

ในอุตสาหกรรม)

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Save > Preserve fidelity when sharing this 
document: เลือกไฟลที่จะทําการฝงฟอนต

กําหนดการฝงฟอนตในเอกสาร

• กําหนดการฝงเฉพาะตัวอักษรที่ใชอยูในเอกสาร ซ่ึงจะชวยลด
ขนาดของไฟล

• กําหนดไมใหมีการฝงฟอนตในระบบ หรือที่ติดมาพรอมกับ 
Windows 

• การฝงฟอนตจะตองเปดไฟลเอกสารข้ึนมากอน แลวจึงเลือก
รายการเอกสารที่กําลังเปดอยูเพื่อทําการฝงฟอนต

• ขอดี เม่ือสงไฟลเอกสารนี้ไปยงัปลายทาง สามารถเปดไฟล
และทําการพิมพหรอืแปลงไฟลไดเลย โดยเครื่องปลายทางไม
ตองมีฟอนตที่ใชงานติดตั้งอยูในระบบ แตไมสามารถแกไขได
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เนื้อหาการฝึกอบรม

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Advanced > Edit Options

ตัวเลือกสําหรับการแกไข ตัวอยางเชน

• การพิมพแกไขแทนที่ขอความที่เลือก

• เม่ือเลือกขอความ ใหเลือกขอความทั้งคําอัตโนมัติ

• อนุญาตใหลากขอความและนาํไปวางในตาํแหนงที่ตองการ

(Drag and Drop)

• ในหมวดตัวเลือกแกไข เปนตัวเลือกที่เกี่ยวกับการทํางานกับ

ขอความเปนหลัก

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Advanced > Image Size and Quality
ตัวเลือกสําหรับกําหนดขนาดและคุณภาพของภาพ

• Discard editing data : หากเลือกคําสั่งนี้ โปรแกรมจะทํา
การลบขอมูลที่จัดเก็บไว (ซ่ึงเปนขอมูลที่ใชในการคืนคา
รูปภาพใหกลับสูสถานะเดิม หลังจากที่มีการแกไขแลว)
หมายเหตุ โปรแกรมจะบันทึกเฉพาะรูปภาพที่แกไขแลว
เทานั้น ขอมูลจากรูปภาพตนฉบับกอนที่จะถูกแกไข
จะไมสามารถนาํมาใชงานได

• Do not compress images in file : การบีบอัดหรือไมบีบ
อัดรูปภาพในไฟล
กรณีเลือกตัวเลือกนี้ คือ ไมตองการบีบอัด เพื่อเก็บรูปภาพ
ใหมีขนาดเต็ม (ขนาดเดิมของไฟลตนฉบับ) ซ่ึงตัวเลือกนี้อาจ
ทําใหแฟมเอกสารมีขนาดใหญ

• Set default target output to: ตองการกําหนดความ

ละเอียดรูปภาพเปนคาตั้งตนไว เม่ือมีการนําผลออก ทั้งใน

รูปแบบอิเล็กทรอนิกส และการพิมพ (ความละเอียดอาจมี

การเปลีย่นแปลงอีกครั้ง ในการข้ันตอนของการแปลงไฟล 

และการพิมพ)
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กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Advanced > Show document Content

แสดงเนื้อหาของเอกสาร

• เปนการแสดงเนื้อหา หรือขอมูลตางๆ ในเอกสาร เชน แสดงสี 

และรูปภาพที่เปนพื้นหลัง ที่ Print Layout view, 

แสดงกรอบการวาดภาพและขอความบนหนาจอ, แสดงกรอบ

วางในตําแหนงที่วางรูปภาพ ชวยทําใหการเลื่อนหนาจอทําได

เร็วข้ึน  เปนตน

• เกี่ยวกับฟอนต เชน ใชแบบรางตัวอักษรสําหรับการดูในโหมด 

Draft และ Outline, การแทนที่ฟอนต หรือการใชฟอนตที่

ติดตั้งอยูในเครื่องพิมพ เปนตน

กําหนดตัวเลือกที่สําคัญกอนการออกแบบจัดหนา

• หมวด Advanced > Print

เก่ียวกับการพิมพ

• ขอกําหนดตางๆ เกี่ยวกับการพิมพผลออก หรือการแปลงไฟล 

เชน การพิมพพื้นหลัง, การพิมพโดยใชคุณภาพแบบดราฟ, 

การพิมพขยายขอความตามขนาดของหนากระดาษ A4 หรือ 

8.5” X 11” 

• กําหนดการพิมพภาษา Postscript สําหรับขอความ หรือพิมพ

เฉพาะขอมูลที่กรอกไวในแบบฟอรม เปนตน
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การสรางเอกสาร

• การสรางเอกสาร สามารถเลือกสรางได ดังนี้

1. สรางเอกสารใหม (New Document) โดยเริ่มจากหนาวาง (Blank Page)

2. สรางเอกสารจาก Template จากแบบรางที่โปรแกรมจัดมาให (สามารถคนหาเพิ่มไดจาก

ออนไลน Microsoft) หรือจากแบบรางที่สรางข้ึนเอง

การสรางเอกสารใหมโดยใชแบบรางของ Microsoft

• การคนหาแบบรางผานระบบออนไลน พิมพหมวดหมูของแบบราง (Template) ที่ตองการคนหาร

เนื้อหาการฝึกอบรม
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การสรางเอกสารใหมโดยใชแบบรางของ Microsoft

การสรางแบบรางขึ้นมาใชเอง

• ออกแบบหนา การกําหนดรูปแบบหนา การวางตําแหนง

ขอความ และรูปภาพตามตองการ เชน จํานวนคอลัมน, 

การกําหนดขนาดตัวหนังสือ การจัดวาง สี ของหัวเรื่อง ตอนที่ 

หนวยที่ เปนตน

• ทําการบันทึกไฟลในรูปแบบ Word Templates เพื่อเลือกใช

งานในภายหลัง (นามสกุล .dotx)

• การเลือกใชงาน Templates โดยเลือกเปดไฟลที่ตองการเปน

แบบรางที่จัดทําไว จากน้ันทําการแทนที่ขอความ รูปภาพ หรือ

องคประกอบอื่นๆ ตามตองการ และทําการบันทึกเปนไฟล

เอกสารใหม

การออกแบบและจัดหนาเอกสาร

• การกําหนดหรือการออกแบบหนาเอกสารหรือหนาส่ิงพิมพ

กําหนดที่เมนู Layout กําหนดขนาด (Size) ขอบเขตหนา (Margins), การวางหนา 

(Orientation) กําหนดคอลัมน (Columns)

สามารถคลิกเลือกทีละคําสั่ง หรือคลิกกําหนดทีเดียวที่ Page Setup
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การแบงหนาและตอน

การแบงหนา (Page Breaks)

• การจัดวางขอความ และจบขอความในแตละเรื่อง หรือคอลมัน

เพื่อข้ึนหนาใหม (Page) ข้ึนคอลัมนใหม (Column) หรือ

การข้ึนขอความที่รอบวัตถุใหม (Text Wrapping)

การแบงตอน (Section Breaks)

• การแบงตอนโดยเริ่มตนตอนใหมบนหนาถัดไป (Next Page)

• การแบงตอนโดยเริ่มตนตอนใหมบนหนาเดียวกันตอเน่ืองไป 

(Continuous)

• การแบงตอนโดยเริ่มตนตอนใหมบนหนาตอไปที่เปนเลขคู

(Even Page)

• การแบงตอนโดยเริ่มตนตอนใหมบนหนาตอไปที่เปนเลขคี่

(Odd Page)

การจัดการพารากราฟ หรือการจัดวางขอความ

การกําหนดยอหนา และระยะหางระหวางบรรทัด

• การจัดวางขอความชิดซาย ชิดขวา จัดกลาง หรือเสมอหนา

หลัง การกําหนดก้ันหนา ก้ันหลัง รวมถึงการเวนระยะหาง

ระหวางพารากราฟ สามารถกําหนดไดที่คําสั่ง Paragraph ใน

แถบคําสั่ง Indents and Spacing

• การจบบรรทัด หรือการจบหนาแลวหยุดข้ึนบรรทัดใหม หรือ

หนาใหม สามารถกําหนดไดที่ Line and Page Breaks

• การกําหนดยอหนา ใหกําหนดเลือกที่ปุ Tabs… จากน้ันเขาไป

กําหนดการยอหนา สามารถระบุระยะหาง ประเภทของยอ

หนา และลักษณะของยอหนา

• ในการกําหนดรูปแบบของพารากราฟ หรอืการจัดวางขอความ 

หลังจากกําหนดเสร็จแลว สามารถต้ังเปนคามาตรฐานได โดย

คลิกเลือกที่ปุม Set As Default
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การสรางรูปแบบขอความหรือคํา (Word Style)

รูปแบบขอความ หรือคํา

• การจัดหนาเอกสาร หรอืสิ่งพิมพ สําหรับการวางขอความที่

ถูกตอง คือ ตองเลือกใชรูปแบบขอความ เพื่อความสะดวก

ในการจัดวางหนา งายตอการเปลี่ยนแปลงแกไขลกัษณะของ

ฟอนต, การจัดวางขอความ 

• การใชรูปแบบขอความ ชวยใหการสรางสารบัญทําไดงายข้ึน

• การใชรูปแบบขอความ สงผลดีตอการทําสื่อสิ่งพิมพ

อิเล็กทรอนิกส (E-Publishing) ชวยใหสารบัญที่สรางข้ึน

เปลีย่นเปนการเช่ือมโยง (Link) โดยอัตโนมัติ

วิธีกําหนดรูปแบบขอความ

แบบขอความ ชวยใหการสรางสารบัญทําไดงายข้ึน

• เลือกเมนู Home จะปรากฏรูปแบบที่มีการกําหนดไวแลว บน

แถบคําสั่งดานบน ใหคลิกที่ปุมขยายคําสั่ง Styles ที่อยู

ดานลางขวา

การสรางรูปแบบขอความหรือคํา (Word Style)

วิธีกําหนดรูปแบบขอความ

แบบขอความ ชวยใหการสรางสารบัญทําไดงายข้ึน

• เลือกเมนู Home จะปรากฏรูปแบบที่มีการกําหนดไวแลว บน

แถบคําสั่งดานบน ใหคลิกที่ปุมขยายคําสั่ง Styles 

ที่อยูดานลางขวา

• คลิกปุม A+ ที่อยูดานลางของคําสั่ง Styles เพื่อสรางรูปแบบ

ขอความข้ึนมาใหม (New Styles) จากน้ันกําหนดรูปแบบ

ที่ตองการ 

• ถาตองการจัดการแกไขเปลี่ยนแปลงรูปแบบที่สรางไวแลว 

ใหคลิกเลือกที่ปุม A ที่มีเครื่องหมายถูก (Manage Styles)

• หากตองการกําหนดรูปแบบฟอนต การจัดวางหนา หรือ

ตัวเลือกในการสรางรูปแบบที่มากข้ึน ใหคลิกเลือกที่ Format 

และเลือกคําสั่งที่แสดงอยูในรายการ
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การกําหนดใชงานคําสั่งอ่ืนๆ ที่เก่ียวขอคําขอความ

การสรางกรอบขอความ (Text Box) 

การสรางตัวอักษรศิลปะ (Word Art)

• สามารถสรางกรอบขอความ หรือตัวอักษรศิลปะไดหลากหลาย

รูปแบบ 

• กรอบขอความ และอักษรศิลปะที่สรางข้ึน สามารถนําไปวางใน

ตําแหนงตางๆ ไดอยางอิสระ 

การสราง Drop Cap

• เลือกตัวอักษรในบรรทัดแรก เลือกคําสั่ง Drop Cap

• หากตองการเปลี่ยนแปลงแกไข ใหเลือก Drop Cap Options

สามารถเปลีย่นตําแหนงการวาง, เปลี่ยนฟอนต, 

จํานวนบรรทัดในสราง Drop Cap

การกําหนดหัวเรื่อง, ทายเรื่อง และเลขหนา

การกําหนดหัวเรื่อง (Header), ทายเรื่อง (Footer) 

และเลขหนา (Page Number)

• กําหนดเลือกรูปแบบที่สรางข้ึนจากรูปแบบขอความ (Word Styles) 

หรือเลือกใชจากระบบออนไลนของ Microsoft.com

• สามารถแกไขเปลี่ยนแปลง Header และ Footer จากคําสั่ง Edit

• กรณี เลขหนา สามารถใสขอมูลอื่นๆ เพิ่มเติมไดดวย 

• การกําหนดหัวเรื่อง ทายเรื่อง และเลขหนา สามารถกําหนดใหหนา

แรกหรือหนาปก มีความแตกตางๆ จากหนาอื่นๆ ได หรือกําหนดให

หนาคู และหนาคี่มีความแตกตางกันไดดวย
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การออกแบบดวยธีม (Themes)

การกําหนดใช Themes 

• เลือกเมนู Design เลือก Themes ที่ตองการ

• ธีมหรือรูปแบบการออกแบบจะเปนชุดฟอนต สี และเอฟเฟก

• เมื่อเลือกใชธีมแลว หากตองการเปลี่ยนแปลงเฉพาะฟอนต สี 

หรือเอฟเฟก ก็สามารถกําหนดได ในชุดคําสั่ง Themes 

• นอกจากน้ัน ยังสามารถเลือกใช Themes จาก Templates 

ของ Microsoft ซ่ึงมีการจัดเตรียมไวในหลายรูปแบบ 

การแทรกขอความ และรูปภาพ

การแทรกขอความ สามารถทําไดหลายวิธี
• การแทรกดวยคําสั่ง Copy และ Paste

• การแทรกดวยคําสั่ง Insert > Objects > Text from File
การแทรกดวยวิธีการน้ี จะเปนการแทรกทั้งไฟล ซ่ึงชวยสรางความแตกตางขนาดของหนาเอกสารได

• การแทรกรูปภาพดวยคําสั่ง Insert > Image หรือ Insert > Object 
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การแทรกขอความ

การแทรกขอความ ดวยคําสั่ง Object > Text From File

• การแทรกดวยวิธีการน้ี จะเปนการแทรกทั้งไฟล 

• การแทรกอาจจะสรางกรอบขอความไวกอน แลวนําขอความจากไฟล

Word หรือไฟล Text ทั่วไป นํามาวางในกรอบขอความ

• เทคนิคการแทรกทั้งไฟล ยังมีประโยชนสําหรับการรวมไฟล 

กรณี ที่ทํางานหลายไฟล สามารถนําไฟลทั้งหมดมารวมกันได เพื่อ

ประโยชนในการสรางสารบัญ, การแปลงไฟล PDF, EPUB หรือ

ใชในการพิมพไฟลเอกสารพรอมกัน

• การแทรกทัง้ไฟล สามารถแทรกระหวางหนา หรือตําแหนงใดตําแหนง

หน่ึงได 

คําแนะนํา ควรสรางหนาวาง หรือ Page Break หรือ Section Break

กอนที่จะทําการแทรกขอความ

การแทรกรูปภาพ

การแทรกรูปภาพ ดวยคําสั่ง Insert > Pictures
• เลือกรูปภาพจากเครื่องคอมพิวเตอร, จากสต็อกรูปภาพ และ

จาก Online

• นอกจากการแทรกรูปภาพแลว ยังสามารถแทรกรปูทรงเลขาคณติ, รูป
สัญลักษณ, กราฟ และกราฟ เปนตน

• รูปภาพที่แทรกมาแลว สามารถปรับปรุงแกไข และใส Effect ตางๆ
ได แตตองพิจารณาปญหาดานการพิมพประกอบดวย 

• Microsoft 365 มาพรอมกับสต็อกรูปภาพ ใหสามารถดาวนโหลด
มาใชไดฟรี  นอกจากภาพแลว ยังมีไอคอน, รูปคนที่มีการไดคัท
พื้นหลัง, สติกเกอร, การตูนตางๆ
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การแทรกรูปภาพ

การแทรกรูปภาพ ดวยคําสั่ง Insert > Pictures
• การแทรกรูป และกําหนดเง่ือนไขในรูปแบบ Link แทนการฝงรปู

จะชวยเรื่องขนาดของไฟล ไมใหมีขนาดใหญเกินไป 

• กรณี ไฟลรูปภาพมีขนาดใหญ ถาใชการฝงรูป จะสงผลใหไฟล Word 
มีขนาดใหญตามไปดวย และมีโอกาสทําใหไฟลเกิด error ได

• เลือกคําสั่ง Insert > Pictures > This Device… จากน้ันเลือกรูปที่
ตองการ เลือกคําสั่ง Link to File (แนะนําใหใชตัวเลือกน้ี กรณี
ไฟลรูปขนาดใหญ และในงานจัดหนามีรูปจํานวนมาก)

• สวนรายการ Insert and Link ภาพจะฝงเหมือนตัวเลือก Insert 
แตจะสามารถ Link กับไฟลรูปภาพดวย

• สําหรับการแทรกรูปแบบ Link จะใชไดกับรูปที่อยูในคอมพิวเตอร
เทาน้ัน คําแนะนํา การเลือกหลายรูปพรอมกัน

• กรณี เลือกรูปที่ไมอยูเรียงตอเน่ืองกัน ใหกด Ctrl และทําการคลิก

เลือกรูปที่ตองการ

• กรณี เลือกรูปทั้งหมด ใหกด Ctrl + A

การกําหนด Effect รูปภาพ

การกําหนด Effect รูปภาพ

• ขอควรระวัง มีบาง Effect ที่กําหนดแลว จะมีผลตอการพิมพผลออก

หรืออาจสงผลตอการสรางสิ่งพมิพอเิลก็ทรอนิกส เชน ไมสามารถใช 

หรือแสดงผลไดในไฟล EPUB เปนตน

• การใชงาน ใหคลิกที่รูปภาพ หลังจากน้ันสามารถคลิกกําหนดรูปแบบ

Effect ที่ตองการ เชน การกําหนดเงาของภาพ, การเปลีย่นโทนสี, 

การลบพื้นหลัง, การใสกรอบ, กําหนดความโปรงใส หรือโปรงแสง, 

กําหนดตําแหนงการวางภาพ และการกําหนดขอความลอมภาพ, 

การตัดภาพ เปนตน

• การกําหนด Effect สามารถเลือกที่ชุดคําสั่งทีส่รางเปนคาต้ังตนไว 

หรือเขาไปกําหนดภายในแตละคําสัง่ โดยปรับคาตางๆ 
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การสรางสารบัญ

การสรางสารบัญ (Table of Contents)
• เพื่อใหงายตอการสรางและเปลี่ยนแปลงสารบัญ จะตองกําหนดสรางจากคําสั่ง Table of Contents 

โดยเปนการสรางสารบัญอัตโนมติั

• การสรางสารบัญอัตโนมติั นํามาซ่ึงการสราง Link อัตโนมัติสําหรับสื่อสิ่งพิมพอิเลก็ทรอนิกส

• การสรางสารบัญ จะตองทํางานรวมกับ Word Styles

วิธีการสรางสารบัญ

การสรางสารบัญ คําสั่ง Reference > Table of Contents

• ไปยังหนาแรกของเอกสาร ใชเคอรเซอรคลิกดานหนาสุดของขอความ

• จากน้ันเลือกคําสั่ง Insert > Page Break โปรแกรมจะสรางหนาวางข้ึนมา 1 

หนา ในตําแหนงกอนหนาขอมูล

• ใชเคอรเซอรคลิกที่หนาวาง จากน้ัน คลิกเลือกรูปแบบสารบัญ จากคําสั่ง 

Table of Contents

• สารบัญ และเลขหนาจะปรากฏข้ึนมา ตาม Word Styles ที่ใช คือ Headline 

1, 2, 3 สามารถกําหนดไดถึงมาก 6 Headline เพื่อใหรองรับกับ EPUB

• หากตองการสรางรูปแบบสารบัญใหม ใหกําหนดที่คําสั่ง Custom Table of 

Content เพื่อกําหนดรูปแบบใหม รวมถึงการเลือกลักษณะของตัวอักษร 

ขนาดตัวอักษร เปนตน

คําแนะนํา กอนการสรางสารบัญ ควรตองเตรียมการไวลวงหนา โดยการ

เลือกใช Word Styles ที่สรางไวสําหรับใชงาน
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วิธีการสรางสารบัญ

การแกไขรูปแบบของ Table of Contents

• กําหนดการแสดงตัวเลข เลือก Show page numbers

• กําหนดใหมีจุด หรือเปนพื้นที่วางระหวางหัวขอสารบัญ กับเลขหนา ใหเลือก

รูปแบบในรายการ Tab leader:

• กําหนดตัวเลือกอื่นๆ ใหคลิกที่ปุม Options… เชน การเพิ่ม Word Style 

Heading เชน เพิ่มเปน Heading 4, Heading 5 และ Heading 6 เปนตน

• กรณี ที่ตองการปรับปรุงแกไขรูปแบบ Table of Contents ใหคลิกเลือกที่ 

Modify…

วิธีการสรางสารบัญ

การ Update สารบัญ

• ใหคลิกเลือกที่ตําแหนงใดตําแหนงหน่ึงของสารบัญ

• จะปรากฏคําวา Update Table of Contents ข้ึนมา ใหคลิกที่ปุมน้ี จะ

ปรากฏ dialog box การ Update ข้ึนมา

• ถาตองการปรับปรุงเฉพาะตัวเลขหนาใหม ใหเลือกคําสั่ง Update page 

numbers only แตถาตองการปรับปรุงใหมทั้งสารบัญ ใหเลือก Update 

entire table 
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การพิมพ และการแปลงไฟลตางๆ

การพิมพเอกสาร และการแปลงไฟล

• การพิมพเอกสาร Word คุณภาพ และรูปแบบการพิมพ ข้ึนอยูกับเครื่องพิมพ โดยกําหนดเง่ือนไขการ

พิมพผาน Printer Driver ซ่ึงแตละเครื่องพิมพก็จะมีคุณสมบัติไมเหมือนกัน

• การแปลงไฟลเพื่อการพิมพ แนะนําใหแปลงเปนไฟล PDF กอนที่จะนําเขาไปสูข้ันตอนการพิมพ

การแปลงไฟล PDF

การแปลงไฟลจาก Word เปน PDF มี 2 วิธี

1. การแปลงไฟลโดยใชคําสั่ง Save As และใชกลไกของ Microsoft เอง

การแปลงไฟลดวยวิธีน้ี จะมีตัวเลือกสําหรับกําหนดคุณสมบัติของไฟล PDF 

ดังน้ี

• Standard (publishing online and printing) เหมาะสาํหรับสิ่งพิมพ

ออนไลน และการพิมพเอกสารทั่วไป เชน การพิมพสําหรับสํานักงาน

• Minimum size (publishing online) เหมาะสําหรับสิ่งพิมพออนไลน 

เพราะไฟล PDF ที่ไดจะมีขนาดเล็ก

หมายเหตุ หากตองการกําหนดเง่ือนไขการแปลงไฟลอื่นๆ เชน จํานวน

หนาที่จะแปลงไฟล, ไฟล PDF มาตรฐาน ใหคลิกเลือกที่ Options
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การแปลงไฟล PDF

การแปลงไฟลจาก Word เปน PDF มี 2 วิธี

2.  การแปลงไฟลโดยโปรแกรม Adobe Acrobat Pro โดยเปนกลไกของ 

Adobe จะผานระบบการแปลงไฟลทีเ่รียกวา Acrobat Distiller ซ่ึงจะมี

คําสั่งฝงอยูในเมนูของ Word ช่ือวา Acrobat 

ซ่ึงวิธีการแปลงดวยกลไกของ Acrobat จะมีคุณภาพที่ดี และเหมาะสม

สําหรับการพิมพในเชิงอุตสาหกรรม ไดดีกวา การแปลงดวยกลไกของ 

Microsoft เอง

หมายเหตุ กอนแปลงไฟล ไฟล PDF ตองกําหนดเง่ือนไขของการแปลง 

โดยเลือกกําหนดที่ Preferences 

การวาดภาพกราฟก และการเขียนสูตรตางๆ

การใชคําสั่ง Draw เพ่ือวาดภาพลายเสน และการเขียนสูตรตางๆ
• ในคําสั่ง Draw การวาดภาพลายเสนรปูทรงอิสระ ดวยการเปลี่ยนขนาด และรปูของปากกา เพื่อใหการ

วาดภาพลายเสนมีมิติมากข้ึน 

• นอกจากการวาดภาพลายเสน สามารถวาดหรือเขียนสูตร เชน สูตรคณิตศาสตร แลวสั่งใหแปลงเปนสตูร
ที่มีการใชฟอนตมาแทนที่ เปนขอความที่สามารถแกไขได เหมือนการพิมพในคําสั่ง Equation
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ผลการดำ�เนินการฝึกอบรม

ผู้เข้าอบรม  จำ�นวน 25 คน  เข้าอบรม 23 คน   ตอบแบบสอบถาม 21 คน

	 ผู้เข้าอบรมเป็นผู้ปฏิบัติงานจากฝ่ายวิชาการ แบ่งเป็น 4 กลุ่ม ตำ�แหน่งงาน ได้แก่ 

	 จากตารางที่ 1 พบว่า ผู้เข้าอบรมตอบแบบประเมินผลการฝึกอบรมจำ�นวน 21 คน (จากผู้เข้าอบรม 23 คน) 

ส่วนใหญ่เป็นเพศหญิง คิดเป็นร้อยละ 90.48 เพศชาย คิดเป็นร้อยละ 9.52  อายุส่วนใหญ่ 50 ปีขึ้นไป คิดเป็นร้อยละ 

47.62 รองลงมา 20-29 ปี และ 40-49 ปี คิดเป็นร้อยละ 14.05 และลำ�ดับสุดท้าย 30-39 ปี คิดเป็นร้อยละ 14.29  

การศึกษาส่วนใหญ่เป็นระดับปริญญาตรี คิดเป็นร้อยละ 71.43 มากกว่าปริญญาโท คิดเป็นร้อยละ 28.57

ตารางที่ 1 แสดงจำ�นวนและร้อยละของข้อมูลทั่วไปของผู้เข้าอบรม ที่ตอบแบบประเมินผล

ข้าราชการ  13 คน

ลูกจ้างประจำ�เงินรายได้  3 คน

พนักงานมหาวิทยาลัย 6 คน

ลูกจ้างชั่วคราวรายเดือน  3 คน

ข้อมูลพื้นฐาน จำ�นวน ร้อยละ

เพศ

   ชาย 2 9.52

   หญิง 19 90.48

   รวม 21 100.00

อายุ

   20-29 ปี 4 19.05

   30-39 ปี 3 14.29

   40-49 ปี 4 19.05

   50 ปีขึ้นไป 10 47.62

   รวม 21 100.00

การศึกษา

   ปริญญาตรี 15 71.43

   ปริญญาโท 6 28.57

   อื่นๆ 0 0

   รวม 21 100.00
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	 จากตารางที่ 2 พบว่า ผู้เข้าอบรมแสดงความพึงพอใจด้านความรู้ความเข้าใจที่ได้รับการฝึกอบรม หัวข้อ 

ผู้ดำ�เนินรายการ/การจัดอบรมมีความเหมาะสม และ หลักสูตรเอื้ออำ�นวยต่อการเรียนรู้และพัฒนาความสามารถของท่าน 

ระดับค่าเฉลี่ย 47.28 มีความพึงพอใจในระดับมากที่สุด หัวข้อเนื้อหาในการฝึกอบรมตรงวัตถุประสงค์ หัวข้อท่าน

สามารถนำ�สิ่งที่ได้รับจากโครงการนี้ไปใช้ในการปฏิบัติงาน มีระดับค่าเฉลี่ย 4.33 และหัวข้อ ระยะเวลาในการฝึกอบรม

มีความเหมาะสม มีระดับค่าเฉลี่ย 4.00 มีความพึงพอใจในระดับมาก

 การแปลความหมายของค่าเฉลี่ย 

	 ค่าเฉลี่ยตั้งแต่ 4.50 – 5.00 หมายถึง มีความพึงพอใจในระดับมากที่สุด

	 ค่าเฉลี่ยตั้งแต่ 3.50 – 4.49 หมายถึง มีความพึงพอใจในระดับมาก

	 ค่าเฉลี่ยตั้งแต่ 2.50 – 3.49 หมายถึง มีความพึงพอใจในระดับปานกลาง

	 ค่าเฉลี่ยตั้งแต่ 1.50 – 2.49 หมายถึง มีความพึงพอใจในระดับน้อย

	 ค่าเฉลี่ยตั้งแต่ 1.00 – 1.49 หมายถึง มีความพึงพอใจในระดับน้อยที่สุด

ความพึงพอใจของผู้เข้าอบรม

	 ผู้เข้าอบรมมีความพึงพอใจด้านความรู้ความเข้าใจที่ได้รับการฝึกอบรม ด้านวิทยากร และ ด้านความรู้ความ

เข้าใจที่ได้จากการฝึกอบรม ดังนี้

ผลการดำ�เนินการฝึกอบรม

ตารางที่ 2 แสดงความพึงพอใจด้านความรู้ความเข้าใจที่ได้รับการฝึกอบรม

หัวข้อ

ระดับความคิดเห็น (ร้อยละ) ค่า

เฉลี่ยมากที่สุด

(5)

มาก

(4)

ปาน

กลาง(3)

น้อย

(2)

น้อย

ที่สุด(1)

ส่วนที่ 1 ด้านความรู้ความเข้าใจที่ได้รับการฝึกอบรม

1. เนื้อหาในการฝึกอบรมตรงวัตถุประสงค์ 40 48 3 - - 4.33

2. ระยะเวลาในการฝึกอบรมมีความเหมาะสม 25 44 15 - 4.00

3. ผู้ดำ�เนินรายการ และการจัดอบรมมีความเหมาะสม 45 48 - - -- 47.28

4. หลักสูตรเอื้ออำ�นวยต่อการเรียนรู้และพัฒนาความสามารถของท่าน 45 48 - - - 47.28

5. ท่านสามารถนำ�สิ่งที่ได้รับจากโครงการนี้ไปใช้ในการปฏิบัติงาน 40 48 3 - - 4.33 
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ตารางที่ 3 ด้านวิทยากร

หัวข้อ

ระดับความคิดเห็น (ร้อยละ) ค่า

เฉลี่ยมากที่สุด

(5)

มาก

(4)

ปาน

กลาง(3)

น้อย

(2)

น้อย

ที่สุด(1)

ส่วนที่ 2 ด้านวิทยากร

1. ความสามารถในการถ่ายทอด/สื่อสาร/ความเข้าใจ 70 28 - - - 4.66

2. การเรียงลำ�ดับบรรยายเนื้อหาได้ครบถ้วน 60 36 - - - 4.57

3. การเปิดโอกาสให้ซักถามและแสดงความคิดเห็น 65 32 - - - 4.61

4. การตอบคำ�ถามได้ตรงประเด็นและชัดเจน 60 36 - - - 4.57

5. ความเหมาะสมของเวลาในการอบรม 45 40 6 - 4.33

	 จากตารางที่ 3 พบว่า ผู้เข้าฝึกอบรมแสดงความพึงพอใจด้านวิทยากร หัวข้อความสามารถในการถ่ายทอด/

สื่อสาร/ความเข้าใจ ระดับค่าเฉลี่ย 4.66 หัวข้อการเปิดโอกาสให้ซักถามและแสดงความคิดเห็น ระดับค่าเฉลี่ย 4.61 

หัวข้อการเรียงลำ�ดับบรรยายเนื้อหาได้ครบถ้วน และหัวข้อการตอบคำ�ถามได้ตรงประเด็นและชัดเจน ระดับค่าเฉลี่ย 

4.57 มีความพึงพอใจในระดับมากที่สุด หัวข้อความเหมาะสมของเวลาในการอบรม ระดับค่าเฉลี่ย 4.33 มีความพึงพอใจ

ในระดับมาก
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ตารางที่ 4 ด้านความรู้ความเข้าใจที่ได้จากการฝึกอบรม

หัวข้อ

ระดับความคิดเห็น (ร้อยละ) ค่า

เฉลี่ยมากที่สุด

(5)

มาก

(4)

ปาน

กลาง(3)

น้อย

(2)

น้อย

ที่สุด(1)

ส่วนที่ 3  ด้านความรู้ความเข้าใจที่ได้จากการฝึกอบรม

1. ความรู้ก่อนฝึกอบรม - - 30 20 1 2.40

2. ความรู้หลังฝึกอบรม 40 48 3 - - 4.33

	 จากตารางที่ 4 พบว่า  ผู้เข้าฝึกอบรมประเมินตนเองด้านความรู้ความเข้าใจที่ได้จากการฝึกอบรม มีความรู้

หลังฝึกอบรม ระดับค่าเฉลี่ย 4.33 มีความรู้ระดับมาก มากกว่าความรู้ก่อนฝึกอบรม ระดับค่าเฉลี่ย 2.40 มีความรู้ระดับ 

ปานกลาง

ข้อเสนอแนะเพิ่มเติม

	 ต้องการให้มีการฝึกอบรมในครั้งต่อไปเพื่อเพิ่มการฝึกปฏิบัติ

	 ควรให้มีการฝึกปฏิบัติ

	 ได้รับความรู้มากค่ะ

	 ได้ความรู้มาก

	 อยากให้มีหลักสูตรของe-book และขอเวลาอบรมมากกว่านี้ค่ะ

	 ขอบคุณค่ะ

	 อยากให้มีการจัดอบรมเชิงลึก e-book และ e-pub

	 ดี สมควรมีการอบรมแบบนี้บ่อยๆ

	 ควรมีแบบฝึกหัดให้ฝึกทำ�

	 ขอให้จัดอบรมการทำ�epubสำ�หรับโปรแกรมindesignด้วยค่ะ
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รายชื่อผู้เข้าฝึกอบรม
รายชื่อผู้เข้าอบรมโครงการฝึกอบรมเชิงปฏิบัติการ 

เรื่อง “การจัดหน้าเอกสารการสอนด้วยโปรแกรม Microsoft Word

 เพื่อรองรับการสร้างหนังสืออิเล็กทรอนิกส์ (E-book)” 

ลำ�ดับที่ รายชื่อ ตำ�แหน่งงาน

1 นางสาวจันทนา เพชรคอน ข้าราชการ

2 นางอุษา สมบัติวงศ์ ข้าราชการ

3 นางสาวกัญจรี ชาญกรอบ ลูกจ้างประจำ�เงินรายได้

4 นางสาวอุไรวรรณ สมสมัย ข้าราชการ

5 นางสาวสมจินตนา นพมิตร ข้าราชการ

6 นางสาวลาภทอง เรืองฤทธิ์ ข้าราชการ

7 นางอรุณี ช้างกระทัด ข้าราชการ

8 นางเปรมฤดี ชัยวัชระณานนท์ ข้าราชการ

9 นางวรรณี อยู่คงดี ข้าราชการ

10 นางสาวกัญญาภัทร ละอองแก้ว ลูกจ้างชั่วคราวรายเดือน

11 นางสาวพรพิมล นุ่นปาน ข้าราชการ

12 นางสาวอัจฉรา อารีย์ พนักงานมหาวิทยาลัย

13 นางพจวรรณ ประภาพรสุข ลูกจ้างประจำ�เงินรายได้

14 นางสาวน้ำ�ฝน รุ่งสว่าง พนักงานมหาวิทยาลัย

15 นางสาวอริศรา แก่นอ้วน พนักงานมหาวิทยาลัย

16 นางสุดารัตน์ บัวศรี ข้าราชการ

17 นางสาวศิริลักษณ์ เรืองเย็น ลูกจ้างประจำ�เงินรายได้

18 นางประดับ ไวยโภคา พนักงานมหาวิทยาลัย

19 นายปิยทัสน์ สังขมาลัย ข้าราชการ

20 นางสาวจตุพร ทองอุ่น ข้าราชการ

21 นางสาวชมชัด อินทกาญจน์ พนักงานมหาวิทยาลัย

22 นายจำ�นงค์ จอมใจเหล็ก ข้าราชการ

23 นายณพีศ์ พรนวม พนักงานมหาวิทยาลัย

24 นางสาวสุวนันท์ สุวรรณเมฆ ลูกจ้างชั่วคราวรายเดือน

25 นางสาวอมรรัตน์ จักรรักษา ลูกจ้างชั่วคราวรายเดือน
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ช่องทางการเผยแพร่การฝึกอบรม

E-Poster  ประชาสัมพันธ์

การฝึกอบรม

สมุดบันทึก 

แจกใช้ในการ

ฝึกอบรม

Facebook Fanpage ถ่ายทอดสดการฝึกอบรม 

Google Forms แบบสอบถามความพึงพอใจในการฝึกอบรม
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ช่องทางการเผยแพร่การฝึกอบรม

Facebook Fanpage ถ่ายทอดสดการฝึกอบรม 
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ช่องทางการเผยแพร่การฝึกอบรม

Google Forms แบบสอบถามความพึงพอใจในการฝึกอบรม
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ภาพการฝึกอบรม

เจ้าของโครงการกล่าวต้อนรับผู้เข้าฝึกอบรม และแนะนำ�วิทยากร

ภาพบรรยากาศฝึกอบรม วันที่ 18 กรกฎาคม 2565

ภาพผู้ฝึกอบรมสอบถาม คำ�ถามเพิ่มเติมในการฝึกอบรม

ภาพอาหาร และอาหารว่างของผู้ฝึกอบรม และวิทยากร
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ภาพการฝึกอบรม

ภาพบรรยากาศฝึกอบรม วันที่ 19 กรกฎาคม 2565

ภาพบรรยากาศฝึกอบรม และของรางวัลตอบคำ�ถามเนื้อหาในการฝึกอบรม


